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CE-SDS Protein Analysis キット 1
CE-SDS Protein Analysis キットは、還元型および非還元型タンパク質をサイズ別に分離し、タン
パク製剤に存在する可能性のある不均一性や不純物を定量するための試薬および消耗品を提供
します。

本書では、CE-SDS Protein Analysis キットを用いたサンプル調製法について説明します。また、
BioPhase ソフトウェアおよび Waters Empower™ソフトウェアを使用した BioPhase 8800 driver
for Empower™ によるデータ取得の手順も説明します。このドキュメントには、BioPhase ソフトウェ
アで取得したデータの分析手順も記載されています。Waters Empower™ソフトウェアで取得したデ
ータの分析は、Waters Empower™ソフトウェアを使用して行う必要があります。

このアプリケーションガイドの情報は、出発点としてご利用ください。必要に応じて、注入時間、電
圧、注入タイプ、その他のパラメータを変更し、最適な条件を探し出してください。

注: システムを安全に使用する手順については、次のドキュメントを参照：オペレータガイド。

安全性
原料と試薬の適切な取り扱いに関する情報については、sciex.com/tech-regulatory で入手可能な
安全データシート (SDS) を参照してください。標準的なラボの安全ガイドラインに常に従ってくださ
い。有害物質情報については、次のセクションを参照: 有害物質情報。

使用目的
CE-SDS Protein Analysis は、ラボ専用です。

はじめに
CE-SDS Protein Analysis キットには、還元型と非還元型のタンパク質をサイズ別に分離し、タン
パク質中に存在する可能性のある不均一性や不純物を定量するための試薬が含まれています。こ
のメソッドでは、ドデシル硫酸ナトリウム（SDS）の存在下で特定の濃度のタンパク質を熱変性しま
す。変性されたサンプルは、交換可能な SDS ポリマーマトリックスを含むキャピラリー内でサイズ別
に分離されます。このマトリックスは、分離のためのふるい分け選択性を提供します。

ワークフロー

ワークフローは次のステップで構成されています。

1. 分析するサンプル数、複製数を決定します。

2. BioPhase software users の場合:

a. メソッドを作成または変更します。次のセクションを参照：メソッド。

b. シーケンスとサンプルおよび試薬プレートのレイアウトを作成します。次のセクションを参
照：シーケンスの作成。

CE-SDS Protein Analysis キット
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3. Waters Empower™ ソフトウェアのユーザーの場合:

a. BioPhase ソフトウェアメソッドをインポートします。次のセクションを参照：BioPhase のソフ
トウェアメソッドをインポートして装置メソッドを作成。

b. サンプルセットメソッドとサンプルおよび試薬プレートのレイアウトを作成します。次のセク
ションを参照：でサンプルセットメソッドを作成。

4. サンプルを調製します。次のセクションを参照：サンプルの調製。

ワークフローは、還元と非還元の 2 つに分かれています。

5. サンプルと試薬のプレートレイアウトを使用して、プレートを準備します。

6. BioPhase 8800 システムにプレートをセットします。次のセクションを参照：サンプルのインレッ
トとアウトレットのプレートをセットおよび試薬のインレットとアウトレットのプレートをセット。

7. データ取得を開始します。

• （BioPhase ソフトウェア）で前面パネルからシーケンスを開始します。次のセクションを参
照：サンプルを実行する。

• （Waters Empower™ソフトウェア）BioPhase 8800 driver for Empower™ を使用して、
Waters Empower™ソフトウェアからサンプルセットメソッドを起動します。次のセクションを参
照：サンプルセットメソッドを開始。

8. データを分析します。

• （BioPhase ソフトウェア） シーケンスが終了したら、BioPhase Analysis ソフトウェアでデー
タを分析します.次のセクションを参照：データの分析。

• （Waters Empower™ソフトウェア）サンプルセットメソッドが完了したら、Waters Empower™

ソフトウェアでデータを分析します。データ分析の手順については、Waters Empower™ソフ
トウェアガイドおよびヘルプファイルを参照してください。

CE-SDS Protein Analysis キット
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必要装置および材料 2
注: 再注文部品番号の付いたアイテムの場合、再注文数量はキット数量と異なる場合があります。

表 2-1 : CE-SDS Protein Analysis キット（PN C30085）

コンポーネント 数量 再注文部品番号

10 kDa Internal Standard 2 A26487

Acid Wash/Regenerating Solution（100 mL） 1 該当なし

Capillary Regenerator Solution A Basic Wash（100 mL） 1 該当なし

CE Grade Water（140 mL） 3 C48034

CE-SDS Gel Buffer（140 mL） 2 A30341

Low pH SDS Sample Buffer（55 mL） 1 C44807

SDS-MW Sample Buffer 1 該当なし

表 2-2 : SCIEX の追加材料

コンポーネント 数量 部品番号

オプション Low pH Phosphate SDS Sample Buffer（40
mM リン酸塩、pH 6.5、1%SDS）（140 mL）

1 C57805

キャピラリーカートリッジクーラント（450 mL） 1 359976

IgG Control Standard（1 mg/mL）（1 mL） 3 391734

MW Size Standard（10 kDa、20 kDa、35 kDa、50 kDa、
100 kDa、150 kDa、225 kDa のタンパク質を含むサイジン
グラダー）（100 µL）

3 A22196

BioPhase 8800 ベアフューズドシリカキャピラリーカートリッ
ジ（内径 50 µm × 30 cm キャピラリー）

1 5080121

BioPhase 8800 アウトレットプレート 20 5080315

BioPhase 8800 試薬プレート 20 5080314

BioPhase 8800 サンプルプレート 20 5080313

BioPhase 8800 スタータープレートパック（サンプルプレート
× 4、試薬プレート× 4、アウトレットプレート× 8）

1 5080311

必要装置および材料
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表 2-3 : 追加の必要な試薬または材料

説明 ベンダー 部品番号

（オプション）Ultracel-10 メンブレンを備えた Amicon Ultra-4
遠心フィルターユニット

MilliporeSigma UFC801024

（オプション）Ultracel-10 メンブレンを備えた MicroCon-10
kDa 遠心フィルターユニット

MilliporeSigma MRCPRT010

（オプション）Ultracel-30 メンブレンを備えた MicroCon-30
kDa 遠心フィルターユニット

MilliporeSigma MRCF0R030

2- メルカプトエタノール MilliporeSigma M7154

ヨードアセトアミド MilliporeSigma I-1149

X-Pierce フィルム USA Scientific 2997-0100

保管条件

注: 調製した試薬の保管条件については、調製手順を参照してください。

• 受領後、10 kDa Internal Standard を 2 °C 〜 8 °C で保管します。

• 残りのキットの内容は室温で保管してください。

顧客が用意する装置および材料
• パウダーフリー加工の手袋（ネオプレンまたはニトリル製のものを推奨）

• 安全メガネ

• ラボ用白衣

• 適切な遠心分離機

• マイクロ遠心分離機または同等品、および微小遠心分離機

• ボルテックスミキサー

• ピペットと適切なのヒント。

試薬プレートの調製には、リピーターピペットまたはそれに相当するものをお勧めします。

• パラフィルム

• プレートを保持するスイングバケットローター付き遠心分離機

• 37 °C ～ 100 °C の温度に対応したウォーターバスまたはヒートブロック

• 分析バランス

• へら

必要装置および材料
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必要な検出器
220 nm フィルター付きの UV 検出器が必要です。

必要なカートリッジ

注意: 結果が不正確になる可能性。カートリッジを CE-SDS Protein Analysis キットで使用してい
る場合、同じカートリッジを他の用途に使用しないでください。異なる緩衝液とサンプルタイプを備え
た同じカートリッジが使用されている場合、サンプルのキャリーオーバー、非特異的結合、および分
離不良が発生する可能性があります。

BioPhase 8800 BFS キャピラリーカートリッジと内径 50 µm × 30 cm のキャピラリーが必要です。

次の表を参照: 表 2-2。

必要装置および材料
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メソッドとシーケンス 3
BioPhase ソフトウェアを使用するシステムの場合

注: 検証済みのメソッドとシーケンスがソフトウェアに含まれていない場合は、SCIEX Web サイトか
らダウンロードできます。次のセクションを参照：必要なファイルをダウンロードして構成（BioPhase
ソフトウェア）。メソッドとシーケンスは、BioPhase ソフトウェアを使用して手動で作成することもでき
ます。次のセクションを参照：メソッド。

以下のメソッドとシーケンスが必要です。

• CE-SDS Conditioning：キャピラリーのコンディションを整えます。

• 分離メソッド：

• 還元 CE-SDS 分離：還元サンプルの場合。

• 非還元 CE-SDS 分離：非還元サンプルの場合。

• 低 pH サンプル緩衝液分離：低 pH のサンプル緩衝液で準備したサンプルの場合。

• CE-SDS シャットダウン：シーケンスの終了時にキャピラリーをクリーニングし、保管のためにキ
ャピラリーをすすいだ後、ランプを消灯します。

• シーケンスのテンプレート：

• 還元 CE-SDS 分離：還元サンプルの場合。

• 非還元 CE-SDS 分離：非還元サンプルの場合。

• 低 pH サンプル緩衝液分離：低 pH のサンプル緩衝液で準備したサンプルの場合。

Waters Empower™ ソフトウェアの検証済みコンピュータの設定

BioPhase ソフトウェア メソッドをインポートして、必要な装置メソッドを作成します。

注: メソッドがソフトウェアに含まれていない場合は、SCIEXWeb サイトからダウンロードできます。
次のセクションを参照：必要なファイルをダウンロードして設定（Waters Empower™ソフトウェア）。メ
ソッドは、Method Editors for BioPhase System ソフトウェアを使用して手動で作成することもでき
ます。次のセクションを参照：メソッド。

シーケンスの作成

注: Waters Empower™ ソフトウェアを使用してデータを取得する場合、この手順は適用されませ
ん。次のセクションを参照：でサンプルセットメソッドを作成。

注: この手順は、BioPhase ソフトウェアに精通していることを前提としています。詳細な手順につい
ては、次のドキュメントを参照：ソフトウェアヘルプシステム。

メソッドとシーケンス
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この手順では、BioPhase ソフトウェアに付属のテンプレートを使用して、シーケンスを作成する方法
を説明します。テンプレートは最初のカラムの 8 サンプルに設定され、ソフトウェアに付属する検証
済みのメソッドを使用します。

テンプレートを使用せずにシーケンスを作成することも可能です。多くの場合、シーケンスはコンディ
ショニング メソッドで始まり、次に分離メソッド、そしてシャットダウン メソッドで終わる必要がありま
す。シャットダウンメソッドをエラー回復メソッドとして割り当てる必要があります。次のドキュメントを
参照：Software Help System。

注: シーケンスに反復サンプルが含まれる場合は、キャピラリー間の変動を減らすために、反復サ
ンプルがサンプル プレートの同じ行にあることを確認してください。

1. BioPhase ソフトウェアの Home ページで、Sequence Editor をクリックします。

2. Open Sequence をクリックします。
Open a Sequence ダイアログが開きます。

3. 適切なシーケンスを検索し、選択します：

a. （オプション）検索の Start Date と End Date を入力するか、カレンダー アイコンをクリッ
クして日付を選択し、Search をクリックします。
利用可能なプロジェクトフォルダが、Folder Name ペインに表示されます。

b. CE-SDS Project プロジェクトフォルダをクリックします。
プロジェクトで利用可能なシーケンスは、右表のとおりです。

c. 表で、適切なシーケンステンプレートをクリックしてから、Open をクリックします。

• 還元サンプルの場合は、CE-SDS テストシーケンスをクリックします。

• 非還元サンプルの場合は、非還元 CE-SDS シーケンスをクリックします。

• 低 pH のサンプル緩衝液で準備したサンプルの場合、低 pH サンプル緩衝液 CE-
SDS シーケンスをクリックします。

Open a Sequence ダイアログが閉じ、Sequence Summary タブが開きます。

4. Sequence Summary ペインの上にある Edit をクリックします。
Sample Plate Setup タブが開きます。

5. 必要に応じて、次のいずれかを行います。

• サンプルを追加または削除します。

• サンプルウェルに割り当てられたメソッドをクリアします。

• サンプルウェルに別のメソッドを割り当てます。

• Sequence Summary 表で、シーケンスのメソッドに回復メソッドを割り当てます。通常は、シ
ャットダウンメソッドを回復メソッドとして割り当てる必要があります。

詳細な手順については、次のドキュメントを参照：Software Help System。

6. 必要に応じて、Sequence Summary 表の情報を編集します。

注: メソッド名は各シーケンスで異なります。

メソッドとシーケンス
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図 3-1 : Sequence Summary 表：CE-SDS テストシーケンス

7. 実行の詳細を表示するには、実行のある行の+をクリックします。

図 3-2 : 展開された Sequence Summary 表

8. 必要に応じて、Sample Id 列と Data File 列の情報を変更します。

9. サンプルプレートと試薬プレートのレイアウトを表示するには、Plates Layout タブを開きます。
必要に応じて、Reagent Plate 内の試薬の位置を編集します。

10. シーケンスを保存するには、SAVE をクリックし、必要な情報を追加します。

注: エラーが発生した場合、 SAVE ボタンは有効になりません。Validation ペインのエラーをす
べて解決し、SAVE をクリックします。

11. （オプション）サンプルプレートと試薬プレートのレイアウトを印刷するには、次を実行します:

a. PRINT をクリックします。
Print Preview ダイアログが開きます。

b. Plate Layout Report をクリックし、Print をクリックします。

メソッドとシーケンス
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c. 印刷オプションを選択し、OK をクリックします。
レポートが印刷されます。

d. 右上隅のクローズボックス、[×]をクリックします。
Print Preview ダイアログが閉じます。

メソッドとシーケンス
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サンプルの調製 4
タンパク質の還元状態と非還元状態の比較により、重要な構造情報が得られます。このセクション
では、還元および非還元の標準サンプルを調製するための手順を説明します。

標準の調製
分析の目的によっては、異なる標準が適している場合もあります。分析に適した標準を使用します。

還元 MW Size Standard の調製

この標準物質は、ジスルフィド結合によるタンパク質の凝集を防ぐため、還元条件下で調製されて
います。

注: 次の手順では、1 つのサンプルの数量を示します。

1. MW Size Standard を十分に混合し、バイアルを標準マイクロ遠心分離機で数秒間回転させ
ます。

2. 0.5 mL のマイクロ遠心分離管に MW Size Standard を 10 µL 加えます。

3. 85 µL の SDS-MW Sample Buffer をマイクロ遠心分離管に加えます。

4. 2 µL の 10 kDa Internal Standard をマイクロ遠心分離管に加えます。

5. 換気フード内のマイクロ遠心分離管に 5 µL の 2-メルカプトエタノールを加えます。

6. バイアルキャップをパラフィルムで固定し、ボルテックスミキサーで十分に撹拌して、混合物を
70 °C のウォーターバスで 10 分間加熱します。

7. 遠心分離機を使用して、チューブを 300g で 1 分間回転させます。

8. バイアルをウォーターバスから取り出し、3 分間以上放置して溶液を室温に冷やします。

この標準物質は約 24 時間安定した状態を保ちます。

9. 調製した標準液を 100 µL サンプルプレートウェルに加えます。

サンプルがあるサンプルプレート上のカラムについては、アウトレットプレート上の対応するカラ
ムに 2.0 mL の CE-SDS Gel Buffer があることを確認します。

10. プレートにフィルムカバーを付け、遠心分離機を使用してサンプルプレートを 30 g で 4 分間回
転させて、ウェルの底にある気泡を取り除きます。

IgG Control Standard の調製

免疫グロブリン製剤の分析には、SCIEX IgG Control Standard を標準として使用できます。この標
準物質は、還元条件または非還元条件下で調製できます。

還元 IgG Control Standard の準備

注: 次の手順では、1 つのサンプルの数量を示します。

サンプルの調製
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1. IgG Control Standard を準備します。

a. 初回の場合は、IgG Control Standard の 1 バイアルをフリーザーから取り出し、室温で
完全に解凍します。

b. ボルテックスミキサーで数秒間軽く混合し、溶液を 95 μL ずつ分注します。

c. 1 分割量を取り分け、残りの分割量を –35 °C 〜 –15 °C で保存します。

2. IgG Control Standard の 95 μL 分割量のうち 1 つを使用します。凍っている場合は室温で解
凍してからご使用ください。

3. 10 kDa Internal Standard 2 µL を IgG バイアルに加えます。

4. 換気フード内の IgG バイアルに 5 µL の 2-メルカプトエタノールを加えます。

5. バイアルキャップでバイアルを固定し、ボルテックスミキサーで十分に撹拌します。

6. 遠心分離機を使用して、バイアルを 300g 使用 1 分間回転させます。

7. バイアルキャップをパラフィルムで固定し、混合物を 70 °C のウォーターバスで 10 分間加熱し
ます。

8. バイアルをウォーターバスから取り出し、3 分間以上放置して溶液を室温に冷やします。

9. 調製した標準液を 100 µL サンプルプレートウェルに加えます。

10. プレートにフィルムカバーを付け、遠心分離機を使用してサンプルプレートを 30 g で 4 分間回
転させて、ウェルの底にある気泡を取り除きます。

非還元 IgG Control Standard の調製

非還元　IgG Control Standard を調製する前に、250 mM のヨードアセトアミド（IAM）溶液を調製し
ます。次のセクションを参照：250 mM Iodoacetamide Solution の調製。

250 mM Iodoacetamide Solution の調製

1. ヨードアセトアミド（IAM）46 mg を秤量し、1.5mL マイクロ遠心分離機バイアルに加えます。

2. CE Grade Water1 mL を加え、46 mg /mL の溶液にします。

3. バイアルをキャップで密封し、固形物が完全に溶けるまで混合します。

4. 使用しないときは、溶液を暗所に保管してください。
ヨードアセトアミド溶液は室温で約 24 時間安定します。

非還元 IgG Control Standard の調製

注: 次の手順では、1 つのサンプルの数量を示します。

1. IgG Control Standard を準備します。

a. 初回の場合は、IgG Control Standard の 1 バイアルをフリーザーから取り出し、室温で
完全に解凍します。

b. ボルテックスミキサーで数秒間軽く混合し、溶液を 95 μL ずつ分注します。

c. 1 分割量を取り分け、残りの分割量を –35 °C 〜 –15 °C で保存します。

サンプルの調製
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2. IgG Control Standard の 95 μL 分割量のうち 1 つを使用します。凍っている場合は室温で解
凍してからご使用ください。

3. 10 kDa Internal Standard 2 µL を IgG Control Standard チューブに加えます。

4. 250 mM IAM　溶液を　5 µL　加えます。

5. キャップでバイアルを固定し、ボルテックスミキサーで十分に撹拌します。

6. 遠心分離機を使用して、バイアルを 300g で 1 分間回転させます。

7. バイアルキャップをパラフィルムで固定し、混合物を 70 °C のウォーターバスで 10 分間加熱し
ます。

8. バイアルをウォーターバスから取り出し、3 分間以上放置して溶液を室温に冷やします。

この標準物質は約 24 時間安定した状態を保ちます。

9. バイアル内の溶液を撹拌し、遠心分離機を使用して 300 g で 1 分間回転させます。

10. 調製した標準液を 100 µL サンプルプレートに加えます。

サンプルがあるサンプルプレート上のカラムについては、アウトレットプレート上の対応するカラ
ムに 2.0 mL の CE-SDS Gel Buffer があることを確認します。

11. プレートにフィルムカバーを付け、遠心分離機を使用してサンプルプレートを 30 g で 4 分間回
転させて、ウェルの底にある気泡を取り除きます。

サンプルの調製
次の手順で、1 つのサンプルを作成します。

推奨タンパク質濃度

SDS-MW Sample Buffer を加えた後、総タンパク質濃度が 0.2 mg/mL から 2 mg/mL の間である
ことが必要です。最良の結果を得るため、タンパク質濃度は 1mg/mL が推奨されています。タンパ
ク質濃度が高すぎると、SDS の結合が不十分となり、ピークがブロード化し、分解能が悪化すること
があります。タンパク質濃度が低すぎる場合、信号レベルが低下する恐れがあります。

また、このアッセイのシグナル強度と分解能は、タンパク質サンプルの塩濃度に敏感に反応します。
塩分濃度が高すぎる場合、信号レベルが低くなるか、ピークテーリングが発生する可能性が高くな
ります。タンパク質サンプルの緩衝液交換を実施を参照してください。

還元サンプルの調製

注: 次の手順では、1 つのサンプルの数量を示します。

1. SDS-MW Sample Buffer でサンプルを 95 µL の量に希釈して、最終タンパク質濃度を
0.2 mg/mL ～ 2 mg/mL にします。

注: SDS-MW Sample Buffer に 45 µL を超えるサンプルを追加していないことを確認します。
45 µL 以下では足りない場合は、サンプルを緩衝液で希釈する前に濃縮してください。

2. 2 µL の 10 kDa Internal Standard をサンプルのマイクロ遠心分離管に加えます。

3. 換気フード内で、マイクロ遠心分離管に 5 µL の 2- メルカプトエタノールを加えます。

サンプルの調製
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4. マイクロ遠心分離管のキャップを固定し、ボルテックスミキサーで十分に撹拌します。

5. 遠心分離機を使って、300 g で 1 分間チューブを回転させます。

6. バイアルキャップをパラフィルムで密封し、70 °C で 10 分間加熱します。

注: タンパク質が高温で安定する場合は、代わりに 100 ℃ で 3 分間加熱することができます。

7. バイアルをウォーターバスから取り出し、3 分間以上放置して溶液を室温に冷やします。

8. サンプルチューブを撹拌し、遠心分離機を使用して 300 g で 1 分間回転させます。

9. 調製したサンプルを 100 µL サンプルプレートに加えます。

サンプルがあるサンプルプレート上のカラムについては、アウトレットプレート上の対応するカラ
ムに 2.0 mL の CE-SDS Gel Buffer があることを確認します。

10. プレートにフィルムカバーを付け、遠心分離機を使用してサンプルプレートを 30 g で 4 分間回
転させて、ウェルの底にある気泡を取り除きます。

非還元サンプルの調製

非還元サンプルを調製する前に、250 mM のヨードアセトアミド (IAM) 溶液を調製します。次のセク
ションを参照：250 mM Iodoacetamide Solution の調製。IAM 溶液は、サンプルの調製中にアルキ
ル化剤として機能し、タンパク質の部分的な自己還元から生じる不均一性を減少させます。

非還元条件の場合、SDS 結合を高めるためにサンプル溶液を高温で加熱する必要があります。た
だし、高温により断片化や凝集が発生し、サンプル分析にアーチファクトが生じる可能性がありま
す。SCIEX では、タンパク質サンプルの温度によるアーチファクトを最小限に抑えるために、このア
ルキル化工程を行うことをお勧めします。SCIEX は、非還元サンプルに対して低 pH SDS サンプ
ル緩衝液のいずれかを使用することも推奨します。Low pH Phosphate SDS Sample Buffer は、
SDS-MW Sample Buffer よりも熱誘導アーチファクトを減少させることが証明されています。

注: 次の手順では、1 つのサンプルの数量を示します。

1. SDS-MW Sample Buffer でサンプルを 95 µL の量に希釈して、最終タンパク質濃度を
0.2 mg/mL ～ 2 mg/mL にします。

注: SDS-MW Sample Buffer に 45 µL を超えるサンプルを追加していないことを確認します。
45 µL 以下では足りない場合は、サンプルを緩衝液で希釈する前に濃縮してください。

2. 2 µL の 10 kDa Internal Standard をサンプルのマイクロ遠心分離管に加えます。

3. 換気フード内で、サンプルチューブに 250 mM IAM 溶液 5 µL を加えます。

4. 遠心分離機を使用してバイアルを 300 g で 1 分間回転させます。

5. バイアルをパラフィルムで密封します。

6. 混合物を 70 °C のウォーターバスで 10 分間加熱します。

7. バイアルをウォーターバスから取り出し、3 分間以上放置して溶液を室温に冷やします。

8. 調製したサンプルを 100 µL サンプルプレートに加えます。

サンプルがあるサンプルプレート上のカラムについては、アウトレットプレート上の対応するカラ
ムに 2.0 mL の CE-SDS Gel Buffer があることを確認します。

サンプルの調製
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9. プレートにフィルムカバーを付け、遠心分離機を使用してサンプルプレートを 30 g で 4 分間回
転させて、ウェルの底にある気泡を取り除きます。

タンパク質サンプルの緩衝液交換を実施
このアッセイのシグナル強度と分解能は、タンパク質サンプルの塩濃度に敏感に反応します。塩濃
度が 1 ×リン酸塩緩衝食塩水（PBS）を超えていると、信号レベルが低くなるか、ピークテーリングが
発生する可能性があります。この手順のステップを使用して、緩衝液の交換を実行します。

注: 他のメーカーのデバイスを使用する脱塩または緩衝液の交換手順については、メーカーのユー
ザー ガイドを参照してください。

注: IgG サンプルの場合、MicroCon-30kDa フィルターは IgG サンプル中の遊離軽鎖（25 kDa）を
ろ過し、偏った純度結果や不正確な結果となることがあるため、使用しないでください。

1. 1mL のタンパク質サンプルを適切な遠心フィルターユニットに追加します。

• IgG サンプルには、Microcon-10kDa 遠心フィルターユニットを使用します。

• その他のタンパク質については、Amicon Ultra-4 遠心フィルターユニットを使用してくださ
い。

2. 遠心分離機を使用してサンプルを 4,000 g で 15 分間回転させます。

3. 次に SDS-MW Sample Buffer2 mL を加え、遠心分離器を用いて試料
4,000 g を 25 分間回転させる。

4. 遠心フィルターユニットを慎重に新しいバイアルに逆さに入れ、遠心分離機でバイアルを
1,000 g で 3 分間回転させます。

タンパク質溶液はバイアルに回収されます。

5. 収集したタンパク質溶液を適切なチューブに移します。

6. タンパク質濃度を判定します。

7. SDS-MW Sample Buffer を最終濃度 1 mL に加えます。

低 pH サンプル緩衝液の使用

注: SCIEX では、Low pH SDS Sample Buffer（トリス、pH 6.8）（CE-SDS Protein Analysis キット
に含まれています）および Low pH Phosphate SDS Sample Buffer（pH 6.5）という 2 種類の異な
る低 pH サンプル緩衝液を用意しています。

サンプルによっては、低い pH のサンプル緩衝液の方が安定している場合があります。分離プロフ
ァイルが繰り返しのたびに変化する場合は、タンパク質が pH 9 である SDS-MW Sample Buffer
において安定していない可能性があります。低 pH 緩衝液を使用してサンプルを再度調製します。

低 pH SDS サンプル緩衝液のいずれかを使用するには、前述のようにサンプルを調製し、SDS-
MW Sample Buffer を Low pH SDS Sample Buffer（pH 6.8）または Low pH Phosphate SDS
Sample Buffer（pH 6.5）に置き換えます。

サンプルの調製
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低 pH 緩衝液ではイオン強度が増加するため、信号損失を防ぐために注入電圧または注入時間を
増やして分離メソッドを変更することをお勧めします。分析するサンプルに基づいて分離時間を調整
します。または、分離メソッドで圧力注入を使用します。

サンプルの調製
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BioPhase 8800 システム用の準備 5
このセクションの手順で、BioPhase 8800 システムのデータ取得の準備をします。

このセクションの手順は、システムがすでに適切にインストールされ、初期化されていることを前提
としています。

ヒント! 時間を節約するために、実行を開始する 30 分前に光源をオンにして、ウォームアップしてお
きます。

試薬のインレットとアウトレットのプレートをセット

注: 気泡を防ぐには、ゲル緩衝液を振ったり、激しく混ぜたりしないでください。気泡は分離不良の
原因になることがあります。

1. 試薬プレートレイアウトに従って、試薬インレットおよびアウトレットのプレートに試薬を加えま
す。次の図を参照：図 D-4。

次の表の量を使用します。

注: アウトレットプレートの場合は、面取りされた角が右上にあることを確認してから、プレート
の左側のウェルのみを充填します。右側のウェルはオーバーフロー用であり、空である必要が
あります。

表 5-1 : 試薬インレットプレートと試薬アウトレットプレートの試薬

プレート 試薬

インレットプレー
ト

ウェルあたり 800 µL

アウトレットプレ
ート

• 分離または待機のための試薬ウェルあたり 2.8 mL

• 廃棄位置の CE Grade Water のウェルあたり 1.5 mL

2. プレートにフィルムカバーを付けます。

注意: システムに損傷を与える恐れ。加熱プレートシーラーを使用してシールを貼らないでくだ
さい。熱によりプレートの表面が損傷し、圧力システムに問題が発生する可能性があります。

注: USA Scientific の X-Pierce フィルムのみが検証されています。別のフィルムを使用する場
合は、使用前にテストしてください。

3. プレートをスイングバケットローターに入れ、30 g で 4 分間回転させます。バケットのバランス
が良いことを確認します。
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注意: 結果が不正確になる可能性。必ずプレートを回転させて気泡を取り除いてからシステム
にセットしてください。気泡があると、分離に失敗することがあります。

4. プレート内に気泡がないことを確認してください。気泡がある場合は、相対遠心力（RCF）を大
きくして再度プレートを回転させます。

試薬プレートの場合、最大 RCF は 1,000 g です。サンプルプレートの場合、最大 RCF は
375 g です。

5. 前面パネルで Eject Reagent をタッチします。

図 5-1 : Eject Reagent ボタン

プレートコンパートメントが開きます。

6. プレートからフィルムカバーを取り外します。

注意: システムに損傷を与える恐れ。フィルムカバーを取り外す前に、プレートをシステムにロ
ードしないでください。運転中にフィルムカバーが存在すると、キャピラリーチップが損傷する可
能性があります。

7. プレートコンパートメントにすでに試薬プレートがある場合は、試薬プレートを取り外してくださ
い。

8. 試薬注入プレートのノッチをタブに合わせて、プレートをプレートキャリアに置きます。

9. 試薬アウトレットプレートの面取りされた角が左上にあることを確認して、プレートをプレートキャ
リアの背面に置きます。

10. Load Reagent をタッチします。

図 5-2 : Load Reagent ボタン

プレートコンパートメントが閉じます。

サンプルのインレットとアウトレットのプレートをセット
1. サンプルプレートレイアウトに従って、サンプルをサンプルインレットプレートに加えます。次の

図を参照：図 D-3。
サンプル量は 100 µL を推奨します。

最小サンプル量は 50 µL です。 最大サンプル量は 200 µL です。
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2. キャピラリーの損傷を防ぐため、すべてのウェルにサンプルがないカラムがある場合は、各空
のウェルに 100 μL から 200 μL のサンプル緩衝液を加える。

カラムにサンプルがない場合、ウェルは空のままにすることができます。

3. サンプルレイアウトに従って、試薬をサンプルアウトレットプレートに加えます。次の図を参照：
図 D-3。
最大容量は 2.0mL です。

次の表の量を使用します。

サンプルがあるサンプルプレート上のカラムについては、アウトレットプレート上の対応するカラ
ムに 2.0 mL の 分離ゲルがあることを確認します。

注: アウトレットプレートの場合は、面取りされた角が右上にあることを確認してから、プレート
の左側のウェルのみを充填します。右側のウェルはオーバーフロー用であり、空である必要が
あります。

表 5-2 : サンプルアウトレットプレートの試薬

プレート 試薬

アウトレットプレ
ート

• ウェルあたり 2.0 mL のゲル緩衝液

4. プレートにフィルムカバーを付けます。

注意: システムに損傷を与える恐れ。加熱プレートシーラーを使用してシールを貼らないでくだ
さい。熱によりプレートの表面が損傷し、圧力システムに問題が発生する可能性があります。

注: USA Scientific の X-Pierce フィルムのみが検証されています。別のフィルムを使用する場
合は、使用前にテストしてください。

5. プレートをスイングバケットローターに入れ、30 g で 4 分間回転させます。バケットのバランス
が良いことを確認します。

注意: 結果が不正確になる可能性。必ずプレートを回転させて気泡を取り除いてからシステム
にセットしてください。気泡があると、分離に失敗することがあります。

6. プレート内に気泡がないことを確認してください。気泡がある場合は、相対遠心力（RCF）を大
きくして再度プレートを回転させます。

試薬プレートの場合、最大 RCF は 1,000 g です。サンプルプレートの場合、最大 RCF は
375 g です。

7. 前面パネルで Eject Sample をタッチします。
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図 5-3 : Eject Sample ボタン

プレートコンパートメントが開きます。

8. プレートからフィルムカバーを取り外します。

注意: システムに損傷を与える恐れ。フィルムカバーを取り外す前に、プレートをシステムにロ
ードしないでください。運転中にフィルムカバーが存在すると、キャピラリーチップが損傷する可
能性があります。

9. プレートコンパートメントにすでにサンプルプレートがある場合は、サンプルプレートを取り外し
てください。

10. サンプルプレートのアライメントノッチがタブと合うように向けて、プレートをプレートキャリアにセ
ットします。

11. サンプルアウトレットプレートの面取りされた隅が左上になるように向けて、プレートキャリアの
奥にプレートをセットします。

12. Load Sample タッチします。

図 5-4 : Load Sample ボタン

プレートコンパートメントが閉じます。

キャピラリーカートリッジの検査

警告! 尖った部分により怪我をする危険。カートリッジの取り扱いは慎重に行ってください。
キャピラリー先端は非常に尖っています。

注意: システムに損傷を与える恐れ。電極、キャピラリーの端、カートリッジシール、またはカートリッ
ジ本体でゲル緩衝液またはその他の試薬を結晶化させないでください。電解質の塩の結晶または
沈殿物は、キャピラリーの詰まり、不適切な圧力シール、サンプル注入時のエラー、アーク放電、ま
たは漏電を引き起こす可能性があります。

1. 使用前に、電極、キャピラリーチップ、カートリッジシール、カートリッジ本体のインターフェース
を検査してください。

2. カートリッジの外側にゲルや液体が付着している場合は、湿らせた糸くずの出ないラボ用の布
でカートリッジをクリーニングします。クリーニング後は、必ずカートリッジを乾燥させます。
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注: カートリッジのクリーニングに石鹸や洗剤は使用しないでください。

3. キャピラリーチップが塞がっている場合は、次の手順を行います。

a. CE Grade Water を使用して、キャピラリーのインレットを洗浄します。

b. 糸くずの出ないラボ用の布を使って、キャピラリーのインレットを外側に向けて丁寧に拭き
ます。

4. 拡大鏡を使って、キャピラリーウィンドウの両側を点検してください。糸くずなどが付着している
場合は、電子機器用の圧縮空気を短時間噴射して除去します。キャピラリーウィンドウのクリー
ニングには、水またはその他の液体を使用しないでください。

注意: システムに損傷を与える恐れ。キャピラリーウィンドウのクリーニングに、メタノール、アセ
トンなどの有機溶剤を使用しないでください。有機溶剤は接着剤を溶かしてしまい、キャピラリ
ーウィンドウに残留物が残り、検出器に干渉する可能性があります。

5. 糸くずの出ないラボ用の布または綿棒をエタノールまたはイソプロピルアルコールで湿らせ、チ
ップの表面を拭きます。カートリッジを取り付ける前に、チップを自然乾燥させてください。

カートリッジの取り付け

警告! 尖った部分により怪我をする危険。カートリッジの取り扱いは慎重に行ってください。
キャピラリー先端は非常に尖っています。

警告! 挟み込みの危険。前面パネルを開けるときは、前面パネルの左側に指を入れないよ
うに注意してください。

注意: システムに損傷を与える恐れ。カートリッジを取り付ける前に、試薬プレートがシステムに取り
付けられていることを確認してください。取り付けていないとカートリッジが損傷する恐れがありま
す。

1. カートリッジが冷蔵庫に保管されていた場合は、システム内の結露を防ぐために、カートリッジ
を室温に均衡させます（約 30 分）。

2. ウェットトレイからカートリッジを取り外します。

3. アーク放電を防ぐために、使い捨てのラボ用の布を使用してカートリッジ本体を乾燥させます。

4. カートリッジの底面を上に向けます。

5. 糸くずの出ないラボ用の使い捨ての布を使用して、キャピラリーと電極がカートリッジから出て
いる部分をやさしく拭きます。シールを損傷しないように注意してください。
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図 5-5 : カートリッジの底部

項目 説明

1 アウトレットプレートシール

2 インレットプレートシール

6. 試薬プレートがシステムに装着されていない場合は、装着します。次のセクションを参照：試薬
のインレットとアウトレットのプレートをセット。

7. 前面パネルを開いて、カートリッジをシステムにセットします。

8. 前面パネルを閉じ、EJECTED をタッチしてカートリッジをロックします。

図 5-6 : イジェクトボタン

カートリッジの寿命を超えた場合は、警告メッセージが前面パネルのログに追加されます。警

告メッセージを表示するには、前面パネルのステータス領域で  をタッチします。カートリッジ
はそのまま使用することも、新しいカートリッジを取り付けることもできます。

BioPhase 8800 システム用の準備

CE-SDS Protein Analysis キット BioPhase 8800 システ
ム用
26/82

アプリケーションガイド
RUO-IDV-05-8662-JA-D



システムは、キャピラリーがカラム 1 の上に位置するように試薬プレートを移動し、プレートを上
昇させて、キャピラリーの両端が CE Grade Water に浸るようにします。

9. 前面パネルのクーラントレベルを検査します。必要に応じて、システムの注入口にクーラントを
追加します。

次のセクションを参照：ドキュメントの「キャピラリーカートリッジクーラントの追加」：オペレータガ
イド。
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サンプルを実行する 6
フロントパネルからシーケンスを開始
Waters Empower™ ソフトウェアの使い方は、次のセクションを参照：サンプルセットメソッドを開始。

1. 必要に応じて、カートリッジ、試薬プレート、およびサンプルプレートをセットします。

2. 前面パネルで RUN SEQUENCE をタッチします。

図 6-1 : RUN SEQUENCE ボタン

3. Projects ペインで、CE-SDS Project をタッチします。

4. Available Sequences ペインで、リスト内の目的とするシーケンスにタッチします。

• 還元サンプルの場合は、CE-SDS テストシーケンスをクリックします。

• 非還元サンプルの場合は、非還元 CE-SDS シーケンスをクリックします。

• 低 pH のサンプル緩衝液で準備したサンプルの場合、低 pH サンプル緩衝液 CE-SDS シ
ーケンスをクリックします。

5. （オプション）メソッド、サンプルプレート、試薬プレートの詳細を表示するには、Method カラム
の任意の場所をタッチします。
詳細を非表示にするには、カラムまたはボックスをもう一度タッチします。

6. Run Sequence をタッチします。

図 6-2 : Run Sequence ボタン

Run Sequence は、システム構成と互換性のないメソッドがシーケンスに含まれている場合、
有効になりません。

データファイルは、シーケンスで指定した場所に保存されます。

実行中にエラーが発生し、エラー回復方法がシーケンスに存在する場合、BioPhase 8800 シ
ステムはエラー回復方法を開始します。

実行中、さまざまなアクションが可能です。次のセクションを参照：BioPhase 8800 フロントパネ
ルで実行のモニタ。

サンプルを実行する
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実行が完了すると、Run Completed ダイアログが開きます。

図 6-3 : Run Completed ダイアログ

7. OK をタッチして、Run Completed ダイアログを閉じます。

8. 必要に応じて、カートリッジを保管します。次のセクションを参照： 実行後にカートリッジを保管。

BioPhase 8800 フロントパネルで実行のモニタ
シーケンスの進行状況をモニタし、必要に応じて、シーケンスの一時停止や停止を行う手順は、以
下のとおりです。

Waters Empower™ ソフトウェアの使い方は、次のセクションを参照：Waters Empower™ソフトウェ
アで実行をモニタ。

注: 以下の図に示すシーケンスは、説明のためのものです。CE-SDS Protein Analysis キットのシ
ーケンスは表示されていません。

1. 検出器と電流のトレースをモニタし、シーケンスが実行されていることを確認します。

2. 問題が検出された場合は、  をタッチして実行を停止し、Warning ダイアログで次のいずれ
かをタッチします。

• Yes：エラー回復方法が割り当てられている場合は、タッチして開始します。

• No：エラー回復方法が割り当てられていない場合はタッチします。

注: 実行を停止すると、サンプルや試薬の損失、カートリッジの損傷につながる恐れがあり
ます。

• 実行を続行するには、Cancel をタッチします。

サンプルを実行する
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図 6-4 : 警告ダイアログ

注意: システムに損傷を与える恐れ。実行が停止され、再開されない場合は、カートリッジを保
管する前にシャットダウン方法を使用してキャピラリーをすすぎます。キャピラリーがすすがれ
ていない場合、電解質の塩の結晶または沈殿物が蓄積し、キャピラリーの詰まり、不適切な圧
力シール、サンプル注入時のエラー、アーク放電、または漏電を収集および引き起こす可能性
があります。

注意: システムに損傷を与える恐れ。分析を再開する前に、試薬のオーバーフローや装置の損
傷を防ぐために、必ずアウトレットプレートを空にするか交換してください。

注意: 結果が不正確になる可能性。運転を再開する前に、新しい試薬プレートを準備します。
運転が停止した場合は、運転の完了に利用できる試薬が十分でない可能性があります。

注意: 結果が不正確になる可能性。サンプルが 24 時間以上システム内にある場合は、分析
を再開する前にサンプルを廃棄してください。劣化している可能性があります。

3. エラーが発生した場合は、表示されるエラーダイアログの OK をタッチしてください。

サンプルを実行する
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図 6-5 : シーケンスの実行エラー

注:  は、Rinse アクションでのエラーを示したものです。Rinse アクションの上の行のグ
レーの網かけは、そのアクションが進行中または完了したことを示します。

4. エラーの確認：

a. 前面パネルログの Events タブの をタッチします。

b. Initialize System をタッチしてシステムを再初期化し、システムステータスをアイドルに変
更します。
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図 6-6 : シーケンスエラーイベントログ

5. 必要に応じて、Pause Run をタッチして実行を一時停止します。

サンプルを実行する
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図 6-7 : 進行中のシーケンス実行

6. 実行を続行するには、Cancel Pause をタッチします。
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図 6-8 : シーケンス実行の再開

7. 取得中のデータを表示するには、リボンの をタッチします。

注: 以下の図のデータは、説明のためのものです。CE-SDS Protein Analysis キットで準備し
たサンプルの結果を示すものではありません。

サンプルを実行する
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図 6-9 : キャピラリービュー

8. （オプション）データの表示をズームインするには、次を実行します。

a. Overlay をタッチします。

b. エレクトロフェログラムの表示を 2 本の指でズームインまたはズームアウトします。

c. 手のアイコンを使ってエレクトロフェログラムを動かします。

注: ズーム機能は、検出器と電流のオーバーレイ表示でのみ機能します。

サンプルを実行する
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図 6-10 : ズームインまたはズームアウト

9. 実行完了時に Sequence run Completed Successfully というメッセージが表示され

ることを確認します。ダイアログで OK をタッチします。

図 6-11 : 実行完了

サンプルを実行する
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廃棄物処理

警告! 生物学的危険、有害化学物質の危険。化学薬品、カートリッジ、試薬プレート、サ
ンプルプレート、および調製したサンプルの残りを廃棄するには、地域の指示に従ってく
ださい。これらには、規制化合物や生物学的危険のある物質が含まれていることがあり
ます。

実行後にカートリッジを保管

警告! 尖った部分により怪我をする危険。カートリッジの取り扱いは慎重に行ってください。
キャピラリー先端は非常に尖っています。

カートリッジの保管期間は 3 日未満

1. シーケンスまたはサンプルセットメソッドにシャットダウンメソッドが含まれていない場合は、シャ
ットダウンメソッドを使用してキャピラリーをクリーニングします。
シャットダウンメソッドは、キャピラリーを CE-SDS Gel Buffer で満たします。

2. キャピラリーの両端を CE Grade Water に浸した状態で、カートリッジをシステムに最大 3 日
間保管します。

注: カートリッジを 3 時間以上使用しなかった場合は、分離を行う前にコンディショニングメソッ
ドを実行してください。

カートリッジを 3 日以上保管

1. シーケンスまたはサンプルセットメソッドにシャットダウンメソッドが含まれていない場合は、シャ
ットダウンメソッドを使用してキャピラリーをクリーニングします。
シャットダウンメソッドは、キャピラリーを CE-SDS Gel Buffer で満たします。

2. CE Grade Water を使用し、80 psi で 10 分間すすいで、キャピラリーをクリーニングします。

3. BioPhase 8800 システム前面パネルのリボンで、 （Loaded）をタッチして約 1 分間
待ちます。

カートリッジを取り外す前に、クーラントがクー ラントリザーバーに戻るのを待ちます。

4. システムからカートリッジを取り外し、キャピラリーの両端を CE Grade Water に浸した状態で
カートリッジボックスに真っすぐ立てて、2 ℃ ～ 8 ℃ で保管します。

注: トレイ内の微生物増殖を防ぐため、トレイ内の CE Grade Water は定期的に交換します。

保管後のカートリッジを準備

• カートリッジを 1 日以上使用していないか、長期間保管していた場合は、CE-SDS Conditioning
メソッドを使用してキャピラリーを調整します。

注: アークを防止するために、カートリッジをシステムに取り付ける前に、電極とカートリッジ本体の
周りの水を注意深く拭き取ってください。

サンプルを実行する
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データの分析 7
分析パラメータファイルによるデータの分析

注: Waters Empower™ソフトウェアを使用してデータを取得する場合、この手順は適用されませ
ん。

次の手順では、解析パラメータ ファイルを使用して BioPhase Analysis ソフトウェアを使用してデー
タを解析する方法を説明します。分析パラメータファイルには、データ中のピークの積算やピークの
同定に必要な情報がすべて含まれています。

注: この手順は、BioPhase ソフトウェアに精通していることを前提としています。詳細な手順につい
ては、次のドキュメントを参照：ソフトウェアヘルプシステム。

注: 本手順の分析パラメータファイルは一例です。すべてのデータファイルに対して最適なパラメー
タであるとは限りません。

1. BioPhase ソフトウェアの Home ページで、Data Analysis をクリックします。
BioPhase Analysis ソフトウェアのメインウィンドウが開きます。

2. File > Open をクリックし、分析するデータ ファイルを選択して、Open をクリックします。

3. Project ツールバーで、 をクリックし、CE-SDS Reduced IgG Analysis に移動し、Open を
クリックします。
CE-SDS Reduced IgG Analysis ファイルは、分析の開始点です。

4. を右クリックし、Apply & Analyze (all)を選択します。

ソフトウェアは、Integration、Library、Post Analysis タブ内のすべてのパラメータをすべての
データファイルに適用し、結果を表示します。

Files ペインでは、データの分析が済んだことを示すために、ファイル名が赤で表示されます。
同定されたピークの数は、Peaks カラムに表示されます。

Data ペインでは、グラフ下の表に分析結果が表示されます。表の上部には、RMS Noise、 P-
P Noise、および Drift が表示されます。グラフでは、ベースラインを赤で、しきい値をグレーの
水平線で示しています。分析で確認されたピークには、ピーク開始に青、ピーク頂点に赤、ピー
ク終点に緑のマーカーが表示されます。

グラフのピークは以下のように網かけされています。

• 緑：ピークは Library タブの Marker Table にあるピークに対応します。

• 青：ピークは Library タブの Peak Table にあるピークに対応します。

• 赤：名前のないピークです。

次のセクションを参照：結果の確認。
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5. グラフにピーク名を表示します。

a.  を右クリックします。
Information Setup ダイアログが開きます。

b. Name およびグラフに表示するその他の情報 MT などを選択し、OK をクリックします。

c. をクリックします。

ピーク名がグラフに表示されます。次のセクションを参照：結果の確認。

名前は分析パラメータファイルの一部です。別の名前を使用する場合は、次のドキュメントの
「ピークの識別」セクションを参照：Software Help System。

6. ファイルリストの下にある Files ペインをクリックし、Up と Down の矢印キーを押すと、各ファイ
ルのデータが Data ペインに表示されます。

必要に応じて、グラフ上の領域をドラッグしてズームインすると、その領域で同定されたピーク
の詳細を確認することができます。

ヒント! データファイルごとにズームインしなくて済むようにするには、  をクリックして、すべて
のデータファイルに同じズーム設定を適用します。

7. 統合が適切であることを確認します。統合パラメータを調整し、必要に応じて再度データを分析
します。

8. Marker Table と Peak Table のピークをエレクトロフェログラムで検査します。

a. Marker Table と Peak Table の各ピークについて、グラフに正しいピークが表示されてい
ることを確認します。

b. 必要に応じて、Marker Table の MT と Peak Table の MT（または Cal MT）を調整しま
す。

c. 必要に応じて、Tol と Crit を調整し、 をクリックします。

• Tol は、グラフのピークと Marker Table または Peak Table のピークを一致させる際の
許容範囲です。許容範囲にパーセンテージを使用する場合は、% と入力します。

• Crit は一致させるピーク特性です。

• Ctr: 範囲の中央に最も近いピークが一致します。

• Ht: 範囲内の最高のピークが一致します。

• Area 領域: 範囲内の最大のピークが一致します。

d. ピークの割り当てに問題がなければ、 を右クリックし、Apply & Analyze (all)を選択し
ます。

ソフトウェアは、すべてのデータファイルに変更を適用します。

9. （オプション）Project ツールバーで、 をクリックし、名前を入力し、場所を選択し、OK をクリ
ックします。
分析パラメータはファイルに保存され、後で使用できます。
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10. （オプション）File ツールバーで、 を右クリックし、Print (all)を選択します。
Data ペインの内容は、最新のレポートテンプレートを使用して印刷されます。レポート テンプレ
ートを作成する手順については、ドキュメントの「レポートの設定」セクションを参照：オペレータ
ガイド

11. File ツールバーで を右クリックし、Save (all)を選択します。
分析パラメータを含む結果の変更は、すべてデータファイルに保存されます。

12. File ツールバーで を右クリックし、Save (all)を選択します。
すべてのデータファイルが閉じます。

結果の確認

図 7-1 : SDS-MW Sample Buffer 内の非還元 IgG サンプル
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図 7-2 : SDS-MW Sample Buffer 中の還元 IgG サンプル

図 7-3 : Low pH SDS Sample Buffer 中の NIST IgG サンプル
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図 7-4 : SDS-MW Sample Buffer 中の MW Size Standard

Overlay タブの Results を確認
Overlay タブには、選択したデータファイルのグラフが表示されます。このタブには、選択したデータ
ファイルの統計情報と、システム適合性レポートが含まれています。

注: このセクションでは、システム適合性機能については説明しません。システム適合性について
は、次のドキュメントを参照：オペレータガイド。

1. データファイルと適切な分析パラメータファイルのセットを開き、データを分析します。必要に応
じて、満足のいく結果が得られるまで分析パラメータを調整します。

2. Files ペインで をクリックし、Overlay タブをクリックします。

データの分析
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図 7-5 : Overlay タブ

グラフのトレースの色は、Files ペインのファイル名の横にある丸の色に対応しています。

太い線は、Files ペインで選択したファイルに対応するトレースです。

3. グラフ右側のスライダーを上下に動かして、トレースを調整します。

注: トレースを一連のタイル状のグラフとして表示するには、スライダーを一番上まで動かしま
す。

4. Overlay タブのすべてのファイルについて結果を計算します。

図 7-6 : 定量テーブル

項目 説明

1 参照ファイル

2 分析の種類
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項目 説明

3 結果をコンマ区切りファイルに保存する

a. 定量テーブルヘッダーの右側にあるリストをクリックし、分析の種類を選択します。

これらのオプションが利用できます。

• Reference - All: Results Table では、参照ファイルに含まれるすべてのピークのう
ち、他のすべてのデータファイルに存在するピークの統計情報を表示します。

• Reference - Peak Table: Results Table では、参照ファイルに含まれるすべての名
前付きピークのうち、他のすべてのデータファイルに存在するピークの統計情報を表示
します。

• Named Peaks: Results Table では、いずれかのデータファイルに含まれるすべての
名前付きピークの統計情報を表示します。

• All Data (not displayed): すべてのデータファイルのすべてのピークの統計情報を計
算しますが、表示しません。

• System Suitability: システムの適合性: データの解析中にシステムの適合性が有効
だった場合、システムの適合性レポートを表示します。

データファイルのピークと参照ファイルのピークは、ピーク頂点の移動時間が 5% 以内で
一致していれば、一致しているとみなします。

b. 左のリストをクリックし、参照ファイルを選択します。

参照ファイルは、他のすべてのファイルと比較されるファイルです。

Reference - All 分析と Reference - Peak Table 分析のみが参照ファイルを使用しま
す。

Results Table が更新され、選択した分析またはシステム適合性レポートが表示されます。

All Data (not displayed)を選択すると、定量テーブルは空になります。結果を表示するに
は、Save をクリックして結果をコンマ区切りファイルに保存し、そのファイルを別のプログラム
で開きます。

5. （オプション）異なる参照ファイルを使用したり、異なるタイプの分析を表示したりする場合は、ス
テップ 4 を繰り返します。

6. (オプション) Save をクリックします。
Results Table は、コンマ区切りテキストファイルに保存されます。表中に表示されているカラム
のみ保存されます。

注: システム適合性の結果を保存するには、File > Save Report をクリックします。結果は
PDF で保存されます。

7. (オプション)File > Print をクリックします。
Overlay タブの内容は、最新のレポートテンプレートに印刷されます。

8. （オプション）File ツールバーで  を右クリックし、Save (all)を選択します。
結果と分析パラメータの変更は、すべてデータファイルに保存されます。
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9. File ツールバーで を右クリックし、Save (all)を選択します。
すべてのデータファイルが閉じます。

合格基準作成のためのガイダンス
SOP またはその他の目的でこのキットを使用するために作成される合格基準は、分離の品質に固
有のパラメータと、重要なサンプルの品質を反映する属性に基づく必要があります。ゲルとキャピラ
リーのロットの違いや装置の違いにより、絶対移動時間にばらつきが生じる可能性があります。

ピーク純度 (ピークの補正面積 % として)、ピーク分解能、および相対移動時間 (10 kDa Internal
Standard SCIEX からのピークまたはサンプル内のメイン ピークを基準マーカーとして使用) は、
CE-SDS 分析で一般的に受け入れられているシステム適合性基準です。SCIEX は、絶対的な移
行時間を合格基準として使用することを強く推奨しません。

MW Size Standard を使用して分子量を推定
未知のタンパク質の分子量を推定するには、X 軸外部マーカー キャリブレーション機能を使用しま
す。次のセクションを参照：外部マーカーを用いたキャリブレーションカーブの作成。

注: 10 kDa Internal Standard が未知の試料中に存在する場合は、10 kDa Internal Standard を
参照ピークとして用い、移動時間の変動を補正し、推定分子量の精度を高めます。

1. MW Size Standard を用いて実行します。

2. BioPhase Analysis ソフトウェアで、MW Size Standard の移動時間と分子量を使用してキャ
リブレーションカーブを作成します。

3. キャリブレーションカーブをデータに適用します。未知のタンパク質の推定分子量は、定量テー
ブルおよびグラフ上の注釈に Cal MT として表示されます（定量テーブルとグラフが表示されて
いる場合）。

SCIEX は、外部キャリブレーションカーブは 24 回実行した後に再度キャリブレートすることをお勧
めします。カーブを再度キャリブレーションするには、MW Size Standard でもう一度実行し、実行の
結果で各標準の移行時間を更新します。

外部マーカーを用いたキャリブレーションカーブの作成

外部マーカーから X 軸のキャリブレーションカーブを生成する場合に使用する機能です。外部マー
カーセットと未知のサンプルの両方に基準マーカーが存在する場合、基準マーカーを使用して移動
時間のばらつきを補正することが可能です。

1. キャリブレーションカーブのパラメータを設定します。

a. 標準を分離した結果を含むデータファイルを開きます。

b. データを積算します。

c. Marker Table で、MW Size Standard のピークをマーカーとして割り当てます。

d. 各マーカーについて、対応する Cal MT セルに分子量を入力します。

e. タブの右側にある Marker Table の上で、External markers を選択します。

f. X-axis Name と Units を入力します。

データの分析

アプリケーションガイド
RUO-IDV-05-8662-JA-D

CE-SDS Protein Analysis キット BioPhase 8800 システ
ム用

45/82



g. Fit Type リストで、キャリブレーションカーブのタイプを選択します。

2. （オプション）未知物質を含むサンプルのデータにおけるピークと参照ピークを照合するための
パラメータを設定します。

a. 参照ピークの Marker Table で Ref を選択します。

b. をクリックします。

c. Ref MT フィールドには、未知物質を含むサンプルのデータにおける参照ピークの予想移
動時間を入力します。

d. Tol フィールドに許容範囲を入力します。

e. Crit リストで、基準を選択します。

f. OK をクリックします。

参照ピークが選択済みの場合は、移動時間に Ref Peak MT （未知）と Ref Peak MT の比率
を乗じることで、キャリブレーションカーブの移動時間が補正されます。この結果、移動時間に
ばらつきがあっても、Cal MT をより正確に判断できます。

3. をクリックし、グラフと定量テーブルを検査して、Cal MT 値が正しいことを確認します。

4. Show Graph をクリックし、Marker Table のデータポイントがキャリブレーションカーブにフィッ
トすることを確認します。
キャリブレーションカーブは、Marker Table の MT と Cal MT 値に基づいています。

5. をクリックし、パラメータを分析パラメータ（dana）ファイルに保存します。

6. File > Open をクリックし、分析するファイルを選択します。

7. ステップ 5 で作成した分析パラメータファイルを開きます。

8. を右クリックし、Apply & Analyze (all)または Apply & Analyze (checked)を選択しま
す。
外部マーカーセットと未知データの両方に参照ピークが存在する場合は、その結果を検査しま

す。必要に応じて、 をクリックし、未知の参照ピークが移行時間ウィンドウ内に見つかるよう
にダイアログで Ref MT、Tol、および Crit の値を調整します。
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Waters Empower™ソフトウェアでサン
プルを実行 8
このセクションでは、Waters Empower™ソフトウェアおよび BioPhase 8800 driver for Empower™

を BioPhase 8800 での使用方法について説明します。

BioPhase のソフトウェアメソッドをインポートして装置
メソッドを作成

注: BioPhase ソフトウェアで作成されたメソッドは、BioPhase 8800 driver for Empower™ に付属
しています。これらのメソッドは、SCIEX Web サイトからダウンロードすることもできます。次のセク
ションを参照：必要なファイルをダウンロードして設定（Waters Empower™ソフトウェア）。

装置メソッドは、Method Editors for BioPhase System ソフトウェアで作成することもできます。次
のドキュメントを参照：オペレータガイドおよび Software Help System。

通常、コンディショニングメソッド、分離メソッド、シャットダウンメソッドの 3 種類のメソッドが必要で
す。一部のワークフローでは、追加のメソッドがあります。

次のメソッドがあります

• CE-SDS Conditioning：キャピラリーのコンディションを整えます。

• 分離メソッド：

• 還元 CE-SDS 分離：還元サンプルの場合。

• 非還元 CE-SDS 分離：非還元サンプルの場合。

• 低 pH サンプル緩衝液分離：低 pH のサンプル緩衝液で準備したサンプルの場合。

• CE-SDS シャットダウン：シーケンスの終了時にキャピラリーをクリーニングし、保管のためにキ
ャピラリーをすすいだ後、ランプを消灯します。

次のステップに従って、BioPhase ソフトウェアメソッドをインポートし、Waters Empower™ソフトウェ
アで使用する装置メソッドとメソッド セットを作成します。ワークフローに適切なメソッドとメソッド セッ
トを作成します。

1. Waters Empower™ Software Project ウィンドウで、File > New Method > Instrument
Method をクリックします。
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図 8-1 : Select Desired Chromatography System ダイアログ

2. 使用するシステムをクリックし、OK をクリックします。

Instrument Method Editor が開きます。

3. Import をクリックし、コンディショニング メソッドを参照します。
メソッドは、Method Settings タブが前面にある Instrument Method Editor ウィンドウで開きま
す。

注: このウィンドウは読み取り専用です。メソッドの変更が必要な場合は、装置メソッドを保存
し、Method Editors for BioPhase System ソフトウェアでメソッドを編集します。次のセクション
を参照：ドキュメントの「既存の装置メソッドを編集」: ソフトウェアヘルプ。

図 8-2 : 装置メソッドエディターの Method Settings タブ
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4. （オプション）Method Program タブを開いてアクションを確認します。

5. アクションのパラメータを表示するには、表内の行をクリックします。
Parameters ペインが更新されてパラメータが表示されます。

図 8-3 : 装置メソッドエディターの Method Program タブ

6. コンディショニング装置メソッドを保存します。

a. File > Save with Method Set をクリックします。
Save current Instrument Method ダイアログが開きます。

b. Name フィールドに名前を入力します。

注: 名前は 30 文字未満である必要があり、英数字、スペース、特殊文字 @、_、% を含
めることができます。Waters Empower™ソフトウェアの一部のバージョンでは、30 文字を
超える文字やその他の特殊文字を使用できますが、メソッドを Method Editors for
BioPhase System ソフトウェアで編集すると、それらの文字が問題を引き起こす可能性が
あります。

c. （オプション）Method Comments フィールドに情報を入力します。

d. プロンプトが表示されたら、Password フィールドに現在のユーザーの Waters Empower
™ソフトウェアのパスワードを入力し、Save をクリックします。

装置メソッドとメソッドセットが現在のプロジェクトに保存されます。

7. File > Exit をクリックします。

注: メソッドをインポートした後は、ウィンドウを閉じてから開かない限り、Instrument Method
Editor ウィンドウの Import ボタンは使用できなくなります。

8. ステップ 3 から 7 を繰り返して、他の装置メソッドおよびメソッド セットを作成します。
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でサンプルセットメソッドを作成
次の手順では、サンプル プレートの 1 列のウェル数である 8 個のサンプルのサンプル セット メソッ
ドを作成します。

注: サンプルセットメソッドにはメソッドセットが必要です。必要な装置メソッドがメソッドセットの一部
であることを確認します。

1. Waters Empower™Software Run Samples ウィンドウで、BioPhase 8800 > BioPhase
Sample Set Editor をクリックします。

Method Editors for BioPhase System ソフトウェアが開き、Sample Set Method Editor ワー
クスペースが表示されます。

2. New Sample Set Method をクリックします。
Sample Set Method Editor が開き、Sample Plate Setup タブが表示されます。

3. Sample Set Summary 表の最初の行で、Method Set Name セルをクリックし、CE-SDS
Conditioning を選択します。

4. Sample Plate Layout ペインで、1 をクリックします。
サンプルプレートの最初の列が選択され、 Sample Set Summary 表が更新されて、選択した
ウェルが表示されます。

図 8-4 : Sample Plate Layout ペイン

5. 必要なサンプル情報を、Sample Set Summary 表に追加します。行 2 ～ 9 で、次を実行しま
す:

a. Sample Name、セルにサンプルの名前を入力します。
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b. Method Set Name セルをクリックし、リストから 還元 CE-SDS 分離または適切な分離メ
ソッドを選択します。

ヒント! 行 2 のメソッド セットを選択した後、右クリックして Apply method to all samples
in column を選択し、メソッドをすべてのサンプルに割り当てます。

6. 最後の行で、Method Set Name セルをクリックし、CE-SDS シャットダウンを選択します。

図 8-5 : Sample Set Summary 表

7. Validation ペインが表示されている場合は、そのペインをクリックしてエラーを表示します。エラ
ーをクリックして発生した場所を強調表示し、必要な変更を行います。

エラーがない場合、Validation ペインは表示されません。

8. サンプルセットメソッドを保存します。

a. SAVE AS をクリックします。

注: エラーが発生した場合、SAVE AS ボタンは有効になりません。Validation ペインのエ
ラーをすべて解決し、SAVE AS をクリックします。

Save Sample Set ダイアログが開きます。

b. Sample Set Name フィールドに名前を入力します。

注: 名前は 30 文字未満である必要があり、英数字、スペース、特殊文字 @、_、% を含
めることができます。Waters Empower™ソフトウェアの一部のバージョンでは、30 文字を
超える文字やその他の特殊文字を使用できますが、メソッドを Method Editors for
BioPhase System ソフトウェアで編集すると、それらの文字が問題を引き起こす可能性が
あります。

c. （オプション） Description フィールドに情報を入力します。

d. Save をクリックし、OK をクリックして保存されたメソッドを確認します。

サンプルセットメソッドは、Waters Empower™ソフトウェアデータベースに保存されます。

9. プレート レイアウトを表示、保存、または印刷するには:

a. Plate Layouts タブを開きます。
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b. (オプション) PRINT をクリックします。
Print Preview ダイアログが開きます。

c. 必要に応じて、ボタンをクリックしてプレート レイアウトを印刷または保存します。

次のセクションを参照：ドキュメントの「印刷プレビュー ダイアログ」：ソフトウェア ヘルプ シ
ステム。

d. 右上隅のクローズボックス、[×]をクリックします。
Print Preview ダイアログが閉じます。

10. Method Editors for BioPhase System ウィンドウ内で、右上隅のクローズ ボックスの[×] をク
リックします。
Method Editors for BioPhase System ソフトウェアが終了し、Run Samples ウィンドウが表示
されます。

サンプルセットメソッドを開始
1. カートリッジとプレートをロードします。次のセクションを参照：BioPhase 8800 システム用の準

備。

2. Waters Empower™ソフトウェア Project ウィンドウで、Tools > Run Samples をクリックしま
す。

図 8-6 : Select Desired Chromatography System ダイアログ

3. 使用するシステムをクリックし、OK をクリックします。
Run Samples ウィンドウが開きます。

4. プレートタイプを設定します。

a. Edit > Plates をクリックします。
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図 8-7 : Define Plates for Sample Set Method ダイアログ

注: ダイアログが前の図のように表示されない場合は、2790 Layout チェックボックスをオ
フにします。

b. Plate Type Name セルをクリックし、ANSI-96well2mL を選択します。
ダイアログが更新され、プレートの画像とプレートシーケンスモードのボタンが表示されま
す。

c. Plate Layout Position セルをクリックして、1 と入力します。

d. をクリックして、実行中のバイアルへのアクセス順を表示します。

e. OK をクリックして変更を保存し、ダイアログを閉じます。

ヒント! プレートの種類を永続的に設定するには、Customize > Defaults をクリック、 Plates
をクリックして、4.e からステップ 4.b を実行し、OK をクリックします。

Sample Set Method 表で、Vials 列の見出しが Plate/Well に変わります。

5. (Load Sample Set) をクリックします。
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図 8-8 : Load Samples ダイアログ

6. Load using a previously created sample set method をクリックし、OK をクリックします。

図 8-9 : Open an existing sample set method ダイアログ

7. リストで CE-SDS Kit Sample Set Method をクリックし、次に Open をクリックします。
サンプルセットメソッドが Samples タブで開きます。

8. (オプション) BioPhase 8800 システムに関連する列のみを表示するように表を構成します。

a. 右クリックして、Table Properties を選択します。
Table Properties ダイアログが開きます。

b. Hide All をクリックし、 Plate/Well、# of Injs、SampleName、Function、および
Method Set / Report or Export Method のチェックボックスをオフにします。
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c. OK をクリックします。

表が更新され、選択した列が表示されます。

図 8-10 : Samples タブ

9. サンプルセットメソッドを確認します。正しい試薬プレートのレイアウトが使用されていることを確
認してください。変更が必要な場合は、Method Editors for BioPhase System ソフトウェアでメ
ソッドを編集します。装置メソッドまたはメソッドセットの変更は、自動的にサンプルセットのメソ
ッドに反映されます。

10. Waters Empower™ Software Project ウィンドウで、 （Start）をクリックします。
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図 8-11 : サンプルセットの実行ダイアログ

11. 必要に応じて、Run Sample Set ダイアログで情報を編集します。

a. 必要に応じて、Name for this sample set フィールドを編集します。

b. （オプション）Shutdown Method をクリックし、キャピラリーをすすぐ装置メソッドを選択し
ます。

使用可能な場合は、SCIEX が提供するすすぎメソッド使用します。すすぎメソッドが利用
できない場合は、作成してください。サンプルセットメソッドと同じ試薬セットと次のパラメー
タを使用します。

• 圧力：50 psi

• 持続時間：2 分

• インレット：水

• アウトレット：水

実行中にエラーが発生した場合、システムはこの装置メソッドを実行し、その後実行を停
止します。

c. 必要に応じて、Do Not Run Shutdown Method During User Abort を選択します。

d. Run をクリックします。
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実行が開始されます。実行中、測定中のサンプルの Sample Set Method ウィンドウの行内の
テキストが赤色で表示されます。

注意: データ損失の可能性。Empower 用の BioPhase 8800 driver for Empower™ システ
ムステータスがアイドル状態であっても、実行中の Direct Control ペイン。いかなるアクション
もデータの取得を妨げる可能性があります。

Waters Empower™ソフトウェアで実行をモニタ
この手順を使用して、サンプル セットメソッドの進行状況をモニタし、必要に応じて一時停止または
停止します。

注: Waters Empower™ソフトウェアのほとんどのペインはクロマトグラフィー用に設計されていま
す。次のステップに従って、キャピラリー電気泳動分離の進行状況を監視し、Time Remaining およ
び Solvent Required ペインの情報を無視します。

1. 問題が検出された場合は、 （Abort）をクリックして実行を中止します。

注意: データ損失の可能性。すべてのデータが保存されるまで実行を停止しないでください。次
の行にサンプルセットメソッドがあるときにデータが保存されます。

注: Direct Control ペインの Stop ボタンは使用しないでください。このボタンは、Direct
Control ペインから開始された機能に対してのみ動作します。

図 8-12 : Abort Options ダイアログ

注意: システムに損傷を与える恐れ。実行が停止され、再開されない場合は、カートリッジを保
管する前にシャットダウン方法を使用してキャピラリーをすすぎます。キャピラリーがすすがれ
ていない場合、電解質の塩の結晶または沈殿物が蓄積し、キャピラリーの詰まり、不適切な圧
力シール、サンプル注入時のエラー、アーク放電、または漏電を収集および引き起こす可能性
があります。
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注意: システムに損傷を与える恐れ。分析を再開する前に、試薬のオーバーフローや装置の損
傷を防ぐために、必ずアウトレットプレートを空にするか交換してください。

注意: 結果が不正確になる可能性。運転を再開する前に、新しい試薬プレートを準備します。
運転が停止した場合は、運転の完了に利用できる試薬が十分でない可能性があります。

注意: 結果が不正確になる可能性。サンプルが 24 時間以上システム内にある場合は、分析
を再開する前にサンプルを廃棄してください。劣化している可能性があります。

実行が終了すると、Sample Set Method ウィンドウのすべての行内のテキストが赤色になりま
す。

2. データの取得中にデータを表示するには、Direct Control ペインで （Monitor）をクリック
します。
Trace View ウィンドウが開き、データが表示されます。

図 8-13 : Trace View ウィンドウ

3. 必要に応じて、次のいずれかを行います。

• 電流、電圧、または圧力を表示するには、左上の該当するタブを開きます。

• すべてのキャピラリーのデータを含む 1 つのグラフを表示するには、左下の Overlay をクリ
ックします。
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• 特定のキャピラリーのデータを表示するには、ウィンドウの下部にあるチェックボックスをオ
ンまたはオフにして、目的のキャピラリーを選択します。

• トレース上の任意の点の時間と検出器の値を表示するには、目的の位置でトレースをクリッ
クします。

• データをズームするには、Overlay が選択されていることを確認し、ドラッグしてズームする
エリアを選択します。マウスのスクロールホイールを使用してズームすることもできます。

• データを元のサイズに戻すには、右下の Reset Zoom をクリックします。

• ズームしたプロットの別の領域を表示するには、X 軸または Y 軸を右クリックしてドラッグし
ます。

4. 必要に応じて、右下にある Auto Zero をクリックします。
検出器信号はゼロに設定されます。

5. Abort ボタン（ ）が赤から緑（ ）に変わるまで待ちます。

データの取得からすべてのデータが保存されるまでに時間がかかる場合があります。緑色の
ボタンは、すべてのデータが保存されたことを示します。

6. 必要に応じて、サンプルと試薬を廃棄します。次のセクションを参照：廃棄物処理。

7. 必要に応じて、カートリッジを保管します。次のセクションを参照： 実行後にカートリッジを保管。
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トラブルシューティング 9
各対策が完了した後、症状が是正されたことを確認するために、再度分析を行うことをお勧めしま
す。

症状 考えられる原因 対策

カートリッジ不検出エ
ラー

1. カートリッジの ID チップが汚
れている。

2. システムの接続ピンが汚れて
いる。

3. BioPhase 8800 システムファ
ームウェアが最新ではない。

1. 糸くずの出ないラボ用の布また
は綿棒をエタノールまたはイソプ
ロパノールで湿らせ、ID チップの
表面を拭きます。ID チップを空
気乾燥させてからカートリッジを
取り付けます。

2. 糸くずの出ないラボ用の布また
は綿棒をエタノールまたはイソプ
ロパノールで湿らせ、接続ピンを
拭きます。ピンを空気乾燥させて
からカートリッジを取り付けます。

3. 次を実行します。

a. BioPhase 8800 システムの
前面パネルで、左上隅のア
イコンをタッチします。

b. ファームウェアのバージョン
を記録します。

c. お問い合わせ先
sciex.com/request-
support。

実行開始時にエラー
が発生

1. カートリッジのウィンドウが結
露したため、実行開始時光学
スキャンに失敗しました。

2. 光学ドアの開閉によりセンサ
ーエラーが発生しました。

1. シャットダウン方法では、結露を
防ぐために Sample Storage 温
度を 20 °C に上げます。

2. 電源を切り、BioPhase 8800 シ
ステムの電源を入れます。必ず
手順に従って UV フィルターを交
換し、指示された以外は光学ドア
を開けないでください。次のセク
ションを参照：ドキュメントの「UV
フィルターの取り付け」：オペレー
タガイド。
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症状 考えられる原因 対策

ピークのブロード化、
分解能の低下

1. キャピラリーの端が損傷してい
る。

2. サンプル濃度が高すぎる。

3. キャピラリーが詰まっている。

4. キャピラリーの内面が汚れて
いる。

1. キャピラリーの端の状態を評価
するには、以下の手順に従いま
す。

• 拡大レンズで点検します。

• 糸くずの出ないラボ用の布を
使って、キャピラリーのインレ
ットを外側に向けて丁寧に拭
きます。

• キャピラリーの端が金のカニ
ューレ電極から約 2 mm 出て
いることを確認します。

• キャピラリーの端が縦切りに
なっていることを確認します。
キャピラリーが使用できない
場合は、次のセクションを参
照：キャピラリーが詰まった、
または損傷した場合のオプシ
ョン。

2. 次のいずれかまたはすべてを行
ってください。

• 分離メソッドの Inject アクショ
ンの Duration を減らして、注
入するサンプルを減らします。
満足のいく結果が得られない
場合は、Pressure または
Voltage を下げます。

• サンプルをサンプル希釈液で
再び希釈します。

3. 次のセクションを参照：キャピラリ
ーが詰まった、または損傷した場
合のオプション。

4. シーケンスを編集して汚染された
キャピラリーを省略するか、カー
トリッジを交換します。
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症状 考えられる原因 対策

キャリーオーバー 1. サンプル濃度が高すぎる。

2. 試薬プレートがサンプルで汚
れている。

1. 次のいずれかまたはすべてを行
ってください。

• 分離メソッドの Inject アクショ
ンの Duration を減らして、注
入するサンプルを減らします。
満足のいく結果が得られない
場合は、Pressure または
Voltage を下げます。

• サンプルをサンプル希釈液で
再び希釈します。

2. 分離メソッドでは、サンプル注入
後に 1 つ以上の水浸ステップを
追加します。編集したメソッドで:

a. この分離メソッドを使用する
新しいシーケンスを作成しま
す。

b. 新しいシーケンスに対応し
た新しい試薬プレートを準備
します。次のセクションを参
照：試薬のインレットとアウト
レットのプレートをセット。

高電流 1. ゲル緩衝液が汚れている。

2. 試薬プレートの試薬の位置が
シーケンス内のプレートレイア
ウトと一致していない。

1. ゲル緩衝液を交換するため、再
度インレット試薬プレートとアウト
レット試薬プレートを準備します。

2. 試薬プレート内の試薬の位置
が、プレートレイアウトと一致して
いることを確認します。位置が正
しくない場合は、プレートレイアウ
トに従ってプレートを再度準備し
ます。 次のセクションを参照：プ
レートのレイアウト。
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症状 考えられる原因 対策

低電流または不安
定な低電流

1. キャピラリーの端が詰まってい
るか、汚染されている。

2. ゲル緩衝液に気泡がある。

1. 次のセクションを参照：キャピラリ
ー内の詰まりを取り除く。電流が
少ない、または安定していない場
合は、カートリッジを交換します。

2. 次のいずれかまたはすべてを行
ってください。

• 遠心分離機を使用して、プレ
ートを 30 g で 5 分間回転さ
せ、気泡を取り除きます。

• 5 インチ Hg から
15 インチ Hg の真空で
5 分間 5 インチ Hg から
15 インチ Hg の真空で
5 分間、ゲル緩衝液を脱気し
ます。

エレクトロフェログラ
ムサンプルにおける
ピークの欠落

1. サンプルの調製中にピペッティ
ングエラーが発生した。

2. メソッドパラメータが正しくな
い。

3. 試薬プレートの試薬の位置が
シーケンス内のプレートレイア
ウトと一致していない。

1. 新しいサンプルを調製します。

2. 次を実行します。

• Method Settings で、
Detector Type の値が正し
いことを確認します。

• 分離メソッド、Type of
Injection と Duration の値
が正しいことを確認します。

• 分離メソッドでは、
Wavelength の値が 220 nm
であることを確認します。

3. サンプルプレート内のサンプル
の位置が、プレートレイアウトと
一致していることを確認します。
位置が正しくない場合は、プレー
トレイアウトに従ってプレートを再
度準備します。 次のセクションを
参照：試薬、プレートのレイアウ
ト、メソッド。
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症状 考えられる原因 対策

分離時に電流がな
い

1. キャピラリーが損傷している。

2. 電極が破損しているか、曲が
っている。

3. キャピラリーの端が詰まってい
るか、汚染されている。

4. 試薬プレートの試薬の位置が
シーケンス内のプレートレイア
ウトと一致していない。

5. キャピラリーが気泡で満ちてい
る。

1. 次のセクションを参照：キャピラリ
ーが詰まった、または損傷した場
合のオプション。

2. カートリッジを交換します。

3. 次のセクションを参照：キャピラリ
ー内の詰まりを取り除く。

4. プレート内のサンプルや試薬の
位置が、プレートレイアウトと一
致していることを確認します。 位
置が正しくない場合は、プレート
レイアウトに従ってプレートを再
度準備します。 次のセクションを
参照：プレートのレイアウト。

5. 次のいずれかまたはすべてを行
ってください。

• サンプルプレートと試薬プレ
ートのウェルに十分な溶液が
あることを確認します。

• 試薬プレート内の試薬の位置
が、プレートレイアウトと一致
していることを確認します。 位
置が正しくない場合は、プレ
ートレイアウトに従ってプレー
トを再度準備します。 次のセ
クションを参照：プレートのレ
イアウト。

• 遠心分離機を使用して、プレ
ートを 30 g で 5 分間回転さ
せ、気泡を取り除きます。

トラブルシューティング
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症状 考えられる原因 対策

ピークなし 1. UV ランプの寿命を超えた。

2. メソッドパラメータが正しくな
い。

3. サンプルウェル内に気泡があ
り、サンプル注入ができない。

4. キャピラリーウィンドウがブロッ
クされている。

5. キャピラリーの端が詰まってい
るか、汚染されている。

6. サンプル量が少なすぎる。

7. サンプルウェルにサンプルが
入っていない、またはサンプル
プレートのサンプルの位置が
シーケンス内のプレートレイア
ウトと一致していない。

1. 次のセクションを参照：ドキュメン
トの「UV ランプの取り付け」：オ
ペレータガイド。

2. 次を実行します。

• Method Settings で、
Detector Type の値が UV
であることを確認します。

• Inject および Separate アク
ションでは、Polarity の値が
Reverse であることを確認し
ます。

• 分離メソッドでは、
Wavelength の値が 220 nm
であることを確認します。

• 分離中にインレットとアウトレ
ットに圧力がかかっていること
を確認します。

3. 遠心分離機を使用して、プレート
を 30 g で 5 分間回転させ、気泡
を取り除きます。

4. キャピラリーウィンドウを調べま
す。ウィンドウがきれいで、パス
が明確であることを確認します。
次のセクションを参照：キャピラリ
ーカートリッジの検査。

5. 次のセクションを参照：キャピラリ
ーが詰まった、または損傷した場
合のオプション。キャピラリーを
調整します。 次のセクションを参
照：キャピラリーの調整。

6. サンプルウェルに 100 μL のサ
ンプルが入っていることを確認し
ます。

7. サンプルプレート内のサンプル
の位置が、プレートレイアウトと
一致していることを確認します。
次のセクションを参照：プレートの
レイアウト。
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症状 考えられる原因 対策

エレクトロフェログラ
ムのスパイク

1. ゲル緩衝液に気泡がある。 1. 次のいずれかまたはすべてを行
ってください。

• 遠心分離機を使用して、プレ
ートを 30 g で 5 分間回転さ
せ、気泡を取り除きます。

• 5 インチ Hg から
15 インチ Hg の真空で
5 分間 5 インチ Hg から
15 インチ Hg の真空で
5 分間、ゲル緩衝液を脱気し
ます。

キャピラリー内の詰まりを取り除く
1. CE Grade Water を使用して、75 psi で 10 分間、キャピラリーを洗浄します。

2. CE Grade Water を使用して、キャピラリーのインレットを洗浄します。

3. 糸くずの出ないラボ用の布を使って、キャピラリーのインレットを外側に向けて丁寧に拭きま
す。

4. キャピラリーの状態を評価するには、次の手順に従います。

a. Direct Control を使用して、キャピラリーに分離ゲルを充填します。

b. 試薬トレイの分離緩衝液の中に、インレットとアウトレットのキャピラリーを入れます。

c. 分離電圧を印加し、電流の安定性をモニタリングします。

5. 詰まりが取れない場合は、シーケンスを編集して破損したキャピラリーを省略するか、またはカ
ートリッジを交換します。

キャピラリーが詰まった、または損傷した場合のオプシ
ョン
キャピラリーの詰まりが除去できない場合やキャピラリーが損傷している場合は、シーケンスを編集
して詰まりや損傷のあるキャピラリーを省きます。次のセクションを参照：シーケンスの作成。

キャピラリーの調整
• 必要に応じて、CE-SDS Conditioning メソッドを用いてキャピラリーを調整します。

トラブルシューティング
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有害物質情報 A
以下の情報に注意し、関連する安全対策を講じる必要があります。詳細な情報については、それぞ
れの安全データシートを参照してください。安全データシートは、ご要望に応じて提供していますが、
当社のウェブサイト sciex.com/tech-regulatory からダウンロードすることもできます。

HCS 2012 による危険物分類。

Acid Wash/Regenerating Solution（0.1 M HCl）

危険! 重度のやけどおよび目の損傷を引き起こします。

Capillary Regenerator Solution A Basic Wash (0.1 M NaOH)

危険! 重度のやけどおよび目の損傷を引き起こします。

CE-SDS Gel Buffer、pH 8、0.2％ SDS

危険! 軽度の皮膚炎を引き起こします。胎児の生殖能力を損なう恐れがあります。

IgG 制御基準

警告! 軽度の皮膚炎を引き起こします。

Low pH SDS Sample Buffer (100 mM Tris-HCL、pH 6.8、1% SDS)

警告! 軽度の皮膚炎を引き起こします。

その他の試薬

これらのコンポーネントは有害物質として分類されていません。

• CE Grade Water

• MW Size Standard

• SDS-MW Sample Buffer

• 10 kDa Internal Standard

他のベンダーの試薬については、使用前にベンダーの安全性データシートをお読みください。

有害物質情報
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必要なファイルのダウンロード C
使用するソフトウェアによって手順が異なります。

• BioPhase ソフトウェアのユーザー、次のセクションを参照：必要なファイルをダウンロードして構
成（BioPhase ソフトウェア）。

• Waters Empower™ソフトウェアのユーザー、次のセクションを参照：必要なファイルをダウンロー
ドして設定（Waters Empower™ソフトウェア）。

必要なファイルをダウンロードして構成（BioPhase ソ
フトウェア）
CE-SDS Protein Analysis キットのメソッド、シーケンス、試薬、および分析パラメータを含むファイ
ルは、sciex.com サイトで入手できます。次の手順に従ってファイルをダウンロードし、次に適切な
場所にコピーします。

注: 以下の手順は、BioPhase ソフトウェアバージョン 1.1 を使用する場合にのみ必要です。CE-
SDS Protein Analysis キットに必要なファイルは、BioPhase ソフトウェア バージョン 1.2 以降の一
部として含まれています。

1. sciex.com/software-support/software-downloads にアクセスし、More software downloads
セクションで BioPhase Resources をクリックします。

2. BioPhase Project Files 1.2をクリックします。

3. File Explorer で BioPhase_1.2.zip ファイルを右クリックし、Extract All をクリックして、イ

ンストールパッケージを展開します。

4. 場所を参照し、Select Folder をクリックして、次に Extract をクリックします。
展開したファイルは、選択したファイル パスにコピーされます。

5. 展開したファイルを正しい場所に配置します。次を実行します。

注: 次の手順では、BioPhase ソフトウェアプロジェクトフォルダがデフォルトの場所にあること
を前提としています: C:\Biophaseプロジェクトフォルダが別の場所にある場合は、展開した

ファイルをその場所に配置します。

a. BioPhase_1.2\Projects\CE-SDS フォルダを C:\BioPhase\Projectsにドラッ

グします。

b. BioPhase_1.2\Reagents\CE-SDS フォルダを C:\BioPhase\Reagentsにドラッ

グします。

c. BioPhase_1.2\Data Analysis\CE-SDS フォルダを

C:\BioPhase\Data Analysisにドラッグします。

必要なファイルのダウンロード
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必要なファイルをダウンロードして設定（Waters
Empower™ソフトウェア）
CE-SDS Protein Analysis キットに必要なファイルは、sciex.com で入手できます。次の手順に従
ってファイルをダウンロードし、次に適切な場所にコピーします。

1. sciex.com/software-support/software-downloads にアクセスし、More software downloads
セクションで BioPhase Driver Resources をクリックします。

2. Click BioPhase Method Files 1.3 をクリックします。

3. File Explorer で BioPhase-Empower-Method-Files-1.3.zip ファイルを右クリックし、

次に Extract All をクリックします。

4. メソッドファイルを保存する場所を参照し、Select Folder をクリックして、Extract をクリックし
ます。
抽出ファイルが抽出され、指定した場所にコピーされます。

必要なファイルのダウンロード
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試薬、プレートのレイアウト、メソッド D
試薬セット
試薬が利用できない場合は、次の図を使用して新しい試薬セットを作成します。次の図を参照：図
D-1 および 図 D-2。

図 D-1 : CE-SDS Protein Analysis キットインレット試薬

試薬、プレートのレイアウト、メソッド
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図 D-2 : CE-SDS Protein Analysis キット アウトレット試薬

プレートのレイアウト

注: 以下の図は、ソフトウェアに付属のシーケンスに対応するプレートのレイアウトです。 プレートの
レイアウトはすべてのシーケンスで共通です。 サンプルの追加や試薬の位置の編集を行った場
合、以下のレイアウトは正しくありません。

サンプルプレート

注: 一番上の行は、サンプル出口プレートのレイアウトを示します。下のセクションは、サンプルイン
レットプレートのレイアウトを示します。

試薬、プレートのレイアウト、メソッド
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図 D-3 : サンプルインレットプレートとサンプルアウトレットプレートのレイアウト

一番上の行は、試薬アウトレットプレートのレイアウトを示します。

注: 一番上の行は、試薬アウトレットプレートのレイアウトを示します。下のセクションは、試薬インレ
ットプレートのレイアウトを示します。

試薬、プレートのレイアウト、メソッド

アプリケーションガイド
RUO-IDV-05-8662-JA-D

CE-SDS Protein Analysis キット BioPhase 8800 システ
ム用

73/82



図 D-4 : 試薬インレットプレートと試薬アウトレットプレートのレイアウト

試薬、プレートのレイアウト、メソッド
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メソッド
メソッドの作成方法については、次のドキュメントを参照：Software Help System。

メソッド設定

注: すべてのメソッドでこの設定を使用します。

図 D-5 : CE-SDS Protein Analysis メソッドのメソッド設定

コンディショニングメソッド

図 D-6 : CE-SDS Conditioning メソッドにおけるアクション

試薬、プレートのレイアウト、メソッド
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図 D-7 : CE-SDS Conditioning メソッドにおけるアクションの概要

非還元サンプルの分離メソッド

図 D-8 : 非還元 CE-SDS 分離メソッドにおけるアクション

試薬、プレートのレイアウト、メソッド
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図 D-9 : 非還元 CE-SDS 分離メソッドにおけるアクションの概要

還元サンプルの分離メソッド

図 D-10 : 還元 CE-SDS 分離メソッドにおけるアクション

試薬、プレートのレイアウト、メソッド
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図 D-11 : 還元 CE-SDS 分離メソッドにおけるアクションの概要

低 pH サンプル緩衝液で調製したサンプルの分離メソッド

図 D-12 : 低 pH サンプル緩衝液分離メソッドにおけるアクション

試薬、プレートのレイアウト、メソッド
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図 D-13 : 低 pH サンプル緩衝液分離メソッドにおけるアクションの概要

シャットダウンメソッド

図 D-14 : CE-SDS シャットダウン メソッドにおけるアクション

試薬、プレートのレイアウト、メソッド
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図 D-15 : CE-SDS シャットダウン メソッドにおけるアクションの概要

試薬、プレートのレイアウト、メソッド
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お問い合わせ先

お客様のトレーニング
• 北米：NA.CustomerTraining@sciex.com

• ヨーロッパ：Europe.CustomerTraining@sciex.com

• ヨーロッパおよび北米以外：sciex.com/education

オンライン学習センター
• SCIEX Now Learning Hub

消耗品と試薬の購入
SCIEX の消耗品と試薬は store.sciex.com からオンラインでご注文いただけます。ご注文の場合
は見積書、注文確認書、または発送書類に記載されているアカウント番号をお使いください。現在
は、米国、英国、ドイツのお客様がオンラインストアにアクセスできますが、今後、他の国にもアクセ
スを拡大する予定です。米国、英国、ドイツ以外のお客様は、地域の SCIEX サービス担当者まで
ご連絡ください。

SCIEX サポート
SCIEX およびその代理店は、十分に訓練を受けた保守/技術専門要員を世界中に配置していま
す。システムまたは起こり得る技術的問題に関するご質問にお答えします。詳細な情報について
は、SCIEX web サイト (sciex.com) を参照するか、以下の連絡先までお問い合わせください。

• sciex.com/contact-us

• sciex.com/request-support

サイバーセキュリティ
SCIEX 製品のサイバーセキュリティに関する最新のガイダンスについては、sciex.com/
productsecurity を参照してください。

ドキュメント
このバージョンのドキュメントは、以前のすべてのバージョンのドキュメントに優先します。

このドキュメントを電子的に閲覧するには Adobe Acrobat Reader が必要です。最新バージョンを
ダウンロードするには、次にアクセスしてください https://get.adobe.com/reader 。

ソフトウェア製品のドキュメントについては、ソフトウェアに付属のリリースノートまたはソフトウェアイ
ンストールガイドを参照してください。

お問い合わせ先
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ハードウェア製品のマニュアルについては、システムまたはコンポーネントに付属の説明書を参照し
てください。

ドキュメントの最新版は SCIEX の web サイト（sciex.com/customer-documents）で入手できま
す。

注: このドキュメントの無料の印刷版を請求するには、sciex.com/contact-us までお問い合わせくだ
さい。

お問い合わせ先
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